Table of Contents

ABOUT MIDDLEBURY AT MILLS INFORMATION TECHNOLOGY AND LIBRARY RESOURCES ................................................................. 4

Information Technology and Library Service Points ................................................................. 4
Mills College Information Technology and Library Telephone Numbers (California) ............... 4
Middlebury College Library and Information Services Telephone Numbers (Vermont) ........... 4

THE LIS WEBSITE ........................................................................................................................................................................... 5

THE TECHNOLOGY HELPDESK .......................................................................................................................................................... 5
Technology Helpdesk Hours of Operation ..................................................................................... 5
Written Documentation ...................................................................................................................................................................... 6
Computer Purchases ......................................................................................................................................................................... 6

COMPUTING SITES AT MILLS COLLEGE ........................................................................................................................................ 6
Get Help From A Reference Librarian ............................................................................................. 7
Materials on Reserve ........................................................................................................................................................................ 8
Search for a Book, CD, Journal Article or Other Material .......................................................... 8
Find and View Videos and DVDs ..................................................................................................... 8
Find Books and Articles on a Particular Subject ............................................................................ 8
Requesting Library Materials through Middlebury's Online Catalog for Interlibrary Loan .......... 8
Use of Computers In The Library ...................................................................................................... 9

GENERAL COMPUTING ADVICE .................................................................................................................................................. 10

GET STARTED WITH COMPUTING ................................................................................................................................. 11
When you arrive at the Mills Campus: ............................................................................................ 11
1. Set Your BannerWeb PIN........................................................................................................11
2. Your Username And Password ..................................................................................................11

THE MILLS COLLEGE NETWORK ........................................................................................12
Things To Know Before Using The Network ............................................................................12
Configure A Windows Computer For The Wireless Network ......................................................13
Configure A Macintosh Computer For The Wireless Network ....................................................14
Network Connectivity For Macintosh Computers ........................................................................15

PRINT YOUR DOCUMENTS ........................................................................................................16
Tips For Conserving Resources ................................................................................................16
Print From Windows Computers ................................................................................................17
  Print From MS Office Applications ............................................................................................17
Print From Macintosh Computers ...............................................................................................18
  Print From MS Office Applications ............................................................................................18

USE GO TO NAVIGATE THE MIDDLEBURY COLLEGE WEBSITE ................................19

ELECTRONIC MAIL AT MIDDLEBURY AT MILLS ..............................................................20
Middlebury at Mills’ Student E-mail Policy ..................................................................................20
E-mail Address vs. Display Name ................................................................................................20
Phishing Expedition Warning ......................................................................................................20

WEBMAIL ..................................................................................................................................21
  WebMail On Any Computer .........................................................................................................21
  Use WebMail To Manage Your Mailbox ....................................................................................23

Forwarding Your Email ..............................................................................................................25
  Set a Forwarding Address ...........................................................................................................25
  Discontinuation Of Forwarding ....................................................................................................25

The Barracuda Spam Firewall ....................................................................................................26

BANNERWEB FOR STUDENTS .................................................................................................27
Your First BannerWeb Login .....................................................................................................27
BannerWeb PIN Changes ............................................................................................................28
Your BannerWeb Security Question ................................................................. 28
If you forget your BannerWeb PIN ................................................................. 28
BannerWeb For Students Menu ............................................................... 29
Special Characters For Windows ................................................................. 30
  Special Character Insertion Using Keystrokes ............................................ 30
Special Characters For The Macintosh ........................................................ 32
  Special Character Insertion Using Keystrokes ............................................ 32
APPENDIX A: YOUR USERNAME AND PASSWORD ................................. 34
APPENDIX B: VPN ......................................................................................... 36
  VPN (Virtual Private Networking) ............................................................... 36
    WebVPN ................................................................................................. 36
INDEX ............................................................................................................. 38
About Middlebury at Mills Information Technology and Library Resources

This guide is provided to help you get started with computing and library use at the Middlebury at Mills summer program. We hope you will keep this as a reference and use it often. You are welcome to take full advantage of any of our many services which are briefly described in the next few pages.

Information Technology and Library Service Points

The F.W. Olin Library is home to the main library collection. The Information Technology Helpdesk is located in Lucie Stern Hall, Room 21. The Audio-Visual Technical Services Office is located in the Fine Arts Annex, Room 113.

Mills College Information Technology and Library Telephone Numbers (California)

- Technology Helpdesk x2005 (510-430-2005)
- Audio Visual Technical Services x2211 (510-430-2211)
- Olin Library Circulation Desk x2196 (510-430-2196)
- Olin Library Reference Desk x2385 (510-430-2385)

Middlebury College Library and Information Services Telephone Numbers (Vermont)

- Middlebury Technology Helpdesk (computing & media services) 802-443-2200
- Main Library Circulation Desk (borrowing services) 802-443-5494
- Main Library Reference Desk (research questions) 802-443-5496
- Armstrong Science Library Circulation Desk 802-443-5449
- Armstrong Science Library Reference 802-443-5018
- Music Library Circulation Desk 802-443-5218
- Music Library Reference Desk 802-443-5785
The LIS Website

Many services are available to you from the Middlebury College Library and Information Services (LIS) webpage. To find the LIS website type http://go.middlebury.edu/lis in the Address field of your browser and press Enter. For specific information about the services of the Technology Helpdesk type http://go.middlebury.edu/helpdesk in the Address field of your browser. There is also a shortcut to the LIS website on the college home page.

GO is a utility that gives easy access to registered pages on the Middlebury College website. To use this utility from Middlebury at Mills use http://go.middlebury.edu/destination.

The Technology Helpdesk

The technology helpdesk is the group to contact with any technology-related questions. Highly-trained consultants answer your calls and work with you to solve problems with software, troubleshoot a hardware problem, or help with any other computing-related issue. If your question requires more in-depth assistance, the technology helpdesk contacts the appropriate resource to solve your problem or provide you with training.

You may contact us to request assistance in the following ways:

- Call the technology helpdesk at x2005 (510-430-2005)
- Send an e-mail message to helpdesk@mills.edu
- Come to the walk-in helpdesk in Lucie Stern Hall, Room 21.

Technology Helpdesk Hours of Operation

Normal hours of operation during the summer are listed below.

- Monday – Friday: 7:00 a.m. – 12:00 p.m. and 1:00 p.m. – 3:30 p.m.

Any available IT staff may answer the helpdesk phone or email outside of these hours.

The helpdesk will be closed on July 4 for the Independence Day Holiday.

Please contact your School Tech Assistant for evening and weekend help.
Written Documentation

Middlebury College LIS provides written documentation with detailed instructions on a variety of computing topics on the Technology Helpdesk website. In the Address field of your browser type http://go.middlebury.edu/docs and press Enter to view our website offerings.

Computer Purchases

Dell and Apple offer discounts to students on certain models of their computers. On the LIS web page (http://go.middlebury.edu/lis), click the Computer Purchase and Repair link and then click on Student Computer Purchases. You will find information on recommended computing systems, sales information for Apple and Dell computers, and an FAQ that will help with your questions. You may also call the Middlebury Technology Helpdesk at 802-443-2200 with questions.

Computing Sites at Mills College

Each language program at Mills has been assigned to a computing lab. All are dual purpose and may have classes scheduled in them for one or more hours per day.

Check your arrival packet for the location of your school’s lab. All computers in labs are on the college network and offer black and white printing. Printing Kiosks may also be available in residence halls. The printing kiosks are not connected to the college network, so you will need to bring the file you want to print on a USB flash drive or a CD or a floppy disk.
Library

Middlebury language materials will be housed in the F.W. Olin Library. The Mills library also has French and Spanish collections, which students in the French and Spanish schools may use. Mills and Middlebury language materials are housed in different sections, using different call number systems. You can locate all materials using the Mills Library catalog. For further information and online access see the Middlebury at Mills portal (http://go.middlebury.edu/lismiddatmills)

Get Help From A Reference Librarian

Reference librarians are happy to provide help searching for library materials. You may contact a Mills reference librarian at x2385 (510-430-2385) or email asklib@mills.edu. Mills reference librarians are normally available during the following hours:

- Mon - Fri 1:00 – 6:00 pm

You can also contact a reference librarian at Middlebury College. Use http://go.middlebury.edu/askus, and choose from among the options (except in person) – email, text a message, or chat.

Borrow Books and Other Library Materials

You will have access to the resources, materials and borrowing accounts of both Middlebury and Mills Colleges.

To view materials borrowed through the Olin Library, or to manage all aspects of your account, log in to My Minerva at http://library.mills.edu/. For questions, please contact the Mills Circulation Desk at x2196 (510-430-2196).

To view materials requested through the Middlebury College Libraries, log in to My Midcat (http://go.middlebury.edu/mymidcat), or http://go.middlebury.edu/ill for materials requested on interlibrary loan.

It is the responsibility of every borrower to ensure the timely return of library materials checked out on their accounts. Replacement charges for materials not returned will be billed to you at the end of the summer session.

Library materials are subject to recall.

Overdue materials may block borrowing and requesting privileges.

Library notices are sent by e-mail. It is the responsibility of the borrower to check their e-mail accounts regularly.
Materials on Reserve
If material is placed On Reserve by your professor it can only be checked out for a limited time so others in your class have a chance to read the assigned material. Reserve materials are available at the Olin Library Circulation Desk. You can look up reserve material by course or instructor name in Minerva, the library’s online catalog (http://library.mills.edu/). Click to search Reserves By Course or Reserves By Faculty.

You can view Electronic Reserve materials from any computer on the network. Go to http://go.middlebury.edu/eres. Your professor will give you the course password required to view the materials.

Search for a Book, CD, Journal Article or Other Material
Check Minerva, Mills College Library’s online catalog (http://library.mills.edu/) for all Mills materials.

Middlebury at Mills students have access to all Journals available on the Vermont Campus. To view Middlebury's journal subscriptions click on the Journals A-Z tab on the Middlebury library home page (http://go.middlebury.edu/lib), or through the link on the Middlebury at Mills LIS home page (http://go.middlebury.edu/lismiddatmills).

Find and View Videos and DVDs
You can find your selection by author/director, title, or keyword by selecting Videos rather than Entire Collection in the search pull down menu. You may also search by subject under Spanish Language Films, French Language Films, Japanese Language Films, or Arabic Language Films.

Find Books and Articles on a Particular Subject
For best results, check with a reference librarian for help finding materials on a particular topic. Reference Librarians can recommend the best search strategies and library databases for your topic. They can also point you to Research Guides for your discipline or class. See section “Getting Help from a Reference Librarian.”

Requesting Library Materials through Middlebury's Online Catalog for Interlibrary Loan
Library resources and materials may be requested on the web via the Middlebury catalog and ILLiad (Interlibrary Loan, http://go.middlebury.edu/illiad), for delivery to the Mills College campus.
Electronic delivery will ensure the fastest possible access to the resources you need, and will be the preferred method of delivery if possible. Materials are also available at the Olin Library.

Please contact Middlebury staff with ILL questions:

Middlebury Interlibrary Loan: e-mail: mdyill@middlebury.edu; Phone: 802-443-5498

**Use of Computers In The Library**

The library has computers with word processing and other software, and you can connect your own laptop to the wireless network at the library.
General Computing Advice

1. Protect your identity and personal information.
   - Change your password often; keep it private.
   - Use secure web sites when providing credit card or bank numbers.
2. Protect your image.
   - Be aware that what you post on a website or Facebook may be searchable and public.
3. Protect your own files.
   - Back up your important files.
4. Protect your computer.
   - Use anti-virus software.
   - Avoid opening messages and files from people or organizations you don't know.
5. Respect the rights of others; don't risk a lawsuit!
   - Don't use your computer, e-mail or the web to harass others.
   - Don't share music and videos you haven't legitimately acquired.
Get Started With Computing

When you arrive at the Mills Campus:

Get the BlueSocket username and password to connect to the Mills network from your arrival packet. This username and password will also be required to work on any Mills College computing equipment and to print.

Then, connect your wireless card to the Mills Wireless network. (Detailed instructions for connecting to the Mills Wireless network are included in this guide in the section *The Mills College Network.*) Open your web browser, and enter your school's BlueSocket username and password.

Mills College also offers an unauthenticated Guest wireless network with the SSID Guest. This network is for Internet access only.

1. Set Your BannerWeb PIN

Also included in your arrival packet will be information about your BannerWeb PIN and your e-mail account. (If you have already matriculated at Middlebury, your BannerWeb PIN and e-mail account will remain the same)

To activate your BannerWeb PIN, go to [http://go.middlebury.edu/bannerweb](http://go.middlebury.edu/bannerweb).

Your BannerWeb PIN is a six-digit number that was originally set to your birth date in MMDDYY format. The first time you log into BannerWeb, the system prompts you to change this to another six-digit number of your choice. Please keep this number confidential. See the section *BannerWeb For Students* for more detailed instructions, and to learn more about BannerWeb and your BannerWeb PIN.

2. Your Username And Password

Once you have activated your your BannerWeb PIN, you can go to [go.middlebury.edu/activate](http://go.middlebury.edu/activate) to learn your username and set your password for your e-mail and file server accounts. This password is between six and eight characters in length and must contain at least two numeric digits and at least two alphabetic characters. Please keep this password confidential. If you have not yet set your password or have forgotten it, see *Appendix A: Your Username And Password.*
The Mills College Network

Things To Know Before Using The Network

All computers connecting to the Mills Network must have virus protection software installed. If you do not have up-to-date virus protection software on your computer, you may download it from Middlebury. Use the following link: http://go.middlebury.edu/sophos. For assistance, please call the Middlebury Technology Helpdesk (computing & media services) 802-443-2200.

- Dial-in (modem) connections are not supported from residence halls.
- No student may attach any additional network equipment, such as a fan-out device, hub, or wireless adapter to a campus network jack, without consulting with and/or obtaining permission from the network technical staff. These devices could cause serious malfunctions of the local network in certain locations. Any unauthorized devices may result in loss of network privileges. Call the technology helpdesk at x2005 (510-430-2005) to obtain the permissions and correct configurations required.

Please bring your computer to the walk-in helpdesk in Stern 21 if you need assistance connecting to the network.

All residence halls at Mills College are equipped with wireless networking. Some residence halls also have Ethernet network connections. To connect to the wireless network, you need a wireless card. To connect to the wired network, you need an Ethernet network interface card (NIC) and an Ethernet cable. Once connected to the network, you will be able to access e-mail and Internet resources. To get started using the network, do the following:

1. If you are using a wireless card, connect your wireless card to the Mills-Wireless network. If you are using a wired connection, plug your computer into the port marked D1 in your room.
2. Turn on your computer and launch your web browser.
3. Log in to BlueSocket with the username and password provided by your language school.
Configure a Windows 7 Computer For The Wireless Network

To use your Windows computer to access the Mills wireless network, follow the instructions below.

1. Click on the wireless icon (looks like cell phone signal bars) in the lower right corner of your screen.
2. Select Mills-Wireless.
3. Check the box next to Connect automatically if you would like your computer to automatically connect to this network.
4. Click Connect.
5. The first time you connect, a window will open asking you to choose a network location. Select Public network.
6. Open your web browser.
7. Log in to Bluesocket with the Language School username and password provided in your arrival packet.

You should now have access to the Internet.

Configure a Windows 8 Computer for the Wireless Network

To use your Windows 8 computer to access the Mills wireless network, follow the instructions below.

1. From the Start screen:
   a. Open the Charms bar by using your mouse to point at the bottom right corner or, if you have a touchscreen, by sliding your finger inward from the screen’s right edge.
   b. Select Settings.
   c. Select the wireless icon (looks like cell phone signal bars).
   d. Select Mills-Wireless.
   e. Check the box next to Connect Automatically if you would like your computer to automatically connect to this network.
   f. Click Connect.
   g. The first time you connect, you will be asked if you want to turn on sharing. Select No, don’t turn on sharing or connect to devices.
   h. Open your web browser.
   i. Log in to Bluesocket with the Language School username and password provided in your arrival packet.
   j. You should now have access to the Internet.

2. From the Desktop:
   a. Select the wireless icon in the bottom right corner (looks like cell phone signal bars).
b. Select Mills-Wireless.
c. Check the box next to Connect Automatically if you would like your computer to automatically connect to this network.
d. Click Connect.
e. The first time you connect, you will be asked if you want to turn on sharing. Select No, don’t turn on sharing or connect to devices.
f. Open your web browser.
g. Log in to Bluesocket with the Language School username and password provided in your arrival packet.
h. You should now have access to the Internet.

Configure A Macintosh Computer For The Wireless Network

To use your Macintosh to connect to the Mills wireless network, follow the instructions below.

1. From the Wi-Fi menu at the top right of your screen, select Mills-Wireless.
2. Open your web browser.
3. Log in to BlueSocket with the username and password provided in your arrival packet.

You should now have access to the Internet.
Network Connectivity For Macintosh Computers
By connecting the Ethernet cable to the wall and to your Macintosh running Mac OS X, you are automatically configured for the network.

1. Open your web browser.
2. Log in to Bluesocket with the username and password provided by your language school.

You should now have access to the Internet.

Network Connectivity For Windows Computers
By connecting the Ethernet cable to the wall and to your PC running Windows, you are automatically configured for the network.

1. In Windows 7, the first time you connect to the Mills network a window will open asking you to choose a network location: select Public network. In Windows 8, the first time you connect to the Mills network you will be asked if you want to turn on sharing: select No, don’t turn on sharing or connect to devices.

2. Open your web browser.

3. Log in to Bluesocket with the Language School username and password provided in your arrival packet.

4. You should now have access to the Internet.
Print Your Documents

We recommend that you save your documents on a USB flash drive or on a CD. Black and white laser printing is free in our computing labs. Please print one copy of your document only and use the copy machines to generate additional copies, if needed. Color printing and copying is available in the Mail and Copy Center in Rothwell Center for academic use. Color printing for non-academic use is available through local commercial vendors such as the UPS Store (aka Mail Boxes Etc.).

Tips For Conserving Resources

You can reduce the environmental impact of printing your papers by following some simple recommendations outlined below.

1. Don’t print e-reserve or other web source material unless truly necessary. Instead of printing the entire document, take notes while reading it on the computer to help you remember important points.
2. Always print double-sided. Thankfully, this is the default on Mills College’s printers.
3. Use Print Preview to see how your document looks before printing.
4. When printing a draft, print multiple pages on one sheet. This can be surprisingly readable at 2-4 pages per sheet. It becomes a tremendous paper-saving technique when you combine this capability with double-sided printing!
5. Please print only one copy of your documents, and use the copy machines to generate additional copies, if needed.
Print From Windows Computers

Print From MS Office Applications

When you issue a print command on any Windows computers, the file is spooled to a server which sends the job to the print queue. You quickly lose the ability to control the printer, even though it has not begun to print. Therefore, it is imperative that you are satisfied with the document before you issue a print command.

1. Open your document.
2. Click on the Page Layout tab to format your document. Click on the various options within the Page Setup ribbon to change printing and file layout options.

Note: If you are printing a document that you received from someone overseas, check the paper size carefully! To do so:
   i. Click on the Size button in the Page Setup ribbon.
   ii. From the Paper Size drop-down list, select Letter.
   iii. From the Office button, select Print and then Print Preview to verify the effects of your choices
   iv. Click on the Page Layout tab, and then click Close Print Preview to return to your document.

3. From the File tab, select Print. In the Print dialog box, you can:
   i. From the Name drop-down list, select the printer. Please note which printer your document is to be sent to!
   ii. In the Page Range section, select as appropriate: All, Current Page, or in the Pages field, enter page numbers and/or page ranges to be printed separated by commas (such as 1,4,6-14).
   iii. Note: Double-sided printing is the default in our computing labs. If you must print single-sided do the following:
      a. On the Print dialog box, click properties. The Properties window opens.
      b. Either uncheck Print on Both Sides or select 1-sided (varies by model of printer).
      c. Click OK.
4. For draft copies, in the Zoom section, select a number from the Pages per sheet drop-down list.
5. Click OK when satisfied with your choices.
Print From Macintosh Computers

Print From MS Office Applications

When you issue a print command on any Macintosh computers, the file is spooled to a server which sends the job to the print queue. You quickly lose the ability to control the printer, even though it has not begun to print. Therefore, it is imperative that you are satisfied with the document before you issue a print command.

1. Open your document.
2. From the Format menu, select Document to format your document. The Document dialog box opens. Click on the Margins, or Layout tabs to change printing and file layout options.

Note: If you are printing a document that you received from someone overseas, check the paper size carefully! To do so:

   a. From the File menu, select Page Setup (or click on the Document dialog box).
   b. From the Paper Size drop-down list, select US Letter.
   c. Click OK.
   d. From the File menu, select Print Preview to verify the effects of your choices, and then click Close to return to your document.
   e. From the File menu, select Print. In the Print dialog box, you can:

      i. From the Printer drop-down list, select the printer. Please note which printer your document is to be sent to!
      ii. In the Copies & Pages section, select as appropriate: All, Current page, Selection, From (then enter the page numbers in the fields following), or Page range (enter page numbers and/or page ranges to be printed separated by commas, such as 1,4,6-14).
      iii. From the third drop-down list, select Layout, and then in the Two Sided Printing section, click the Long-Edge Binding (Portrait) or Short-Edge Binding (Landscape) radio button.
      iv. For draft copies, from the third drop-down list, select Layout, and then select a number from the Pages per Sheet drop-down list (2-4 pages/sheet are surprisingly readable).
      v. Click Print when satisfied with your choices.
Use GO To Navigate the Middlebury College Website

**GO** is a utility that provides a fast way to navigate to many common services on the Middlebury website. To use it, type a **GO Quick Text** (such as http://go.middlebury.edu/helpdesk) into your browser’s **Address** field. You will have immediate access to the pages you want to use. There hundreds of registered **GO** definitions that can be used while you are on-campus or off-campus. Some commonly-used ones and many of the ones for LIS are:

<table>
<thead>
<tr>
<th>To find this website</th>
<th>Type when not on Middlebury campus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Password</td>
<td><a href="http://go.middlebury.edu/activate">http://go.middlebury.edu/activate</a></td>
</tr>
<tr>
<td>Middlebury Email</td>
<td><a href="http://go.middlebury.edu/webmail">http://go.middlebury.edu/webmail</a></td>
</tr>
<tr>
<td>E-mail Forwarding</td>
<td><a href="http://go.middlebury.edu/forward">http://go.middlebury.edu/forward</a></td>
</tr>
<tr>
<td>BannerWeb</td>
<td><a href="http://go.middlebury.edu/bw">http://go.middlebury.edu/bw</a></td>
</tr>
<tr>
<td>Language School</td>
<td><a href="http://go.middlebury.edu/ls">http://go.middlebury.edu/ls</a></td>
</tr>
<tr>
<td>LIS main page</td>
<td><a href="http://go.middlebury.edu/lis">http://go.middlebury.edu/lis</a></td>
</tr>
<tr>
<td>“How-To” Guides</td>
<td><a href="http://go.middlebury.edu/docs">http://go.middlebury.edu/docs</a></td>
</tr>
<tr>
<td>E-mail a librarian</td>
<td><a href="http://go.middlebury.edu/askalibrarian">http://go.middlebury.edu/askalibrarian</a></td>
</tr>
<tr>
<td>Search for materials</td>
<td><a href="http://go.middlebury.edu/midcat">http://go.middlebury.edu/midcat</a></td>
</tr>
<tr>
<td>Your library account</td>
<td><a href="http://go.middlebury.edu/mymidcat">http://go.middlebury.edu/mymidcat</a></td>
</tr>
<tr>
<td>Inter-library Loan</td>
<td><a href="http://go.middlebury.edu/ill">http://go.middlebury.edu/ill</a></td>
</tr>
<tr>
<td>Course Reserves</td>
<td><a href="http://go.middlebury.edu/reserves">http://go.middlebury.edu/reserves</a></td>
</tr>
<tr>
<td>Electronic Reserves</td>
<td><a href="http://go.middlebury.edu/eres">http://go.middlebury.edu/eres</a></td>
</tr>
<tr>
<td>Subject guides</td>
<td><a href="http://go.middlebury.edu/subjectguides">http://go.middlebury.edu/subjectguides</a></td>
</tr>
<tr>
<td>Midd-at-Mills LIS Portal</td>
<td><a href="http://go.middlebury.edu/lismiddatmills">http://go.middlebury.edu/lismiddatmills</a></td>
</tr>
</tbody>
</table>
Electronic Mail at Middlebury at Mills

Please read the next few policy sections before using electronic mail. We recommend that students use WebMail for their electronic communications. WebMail is easy to use (instructions begin on the following page) and is accessible from any networked computer in the world.

Middlebury at Mills’ Student E-mail Policy

E-mail is considered an official method for communicating with students in the Middlebury at Mills Program. Official e-mail communications are intended to meet the academic and administrative needs of the campus community. The College expects that such communications, many of which are time-critical, will be received and read in a timely fashion. To enable this process, the College ensures that all students are issued a standardized college e-mail account through their academic years at Middlebury College. Students who choose to forward e-mail from their College e-mail accounts are responsible for ensuring that all information, including attachments, is transmitted in its entirety to the preferred account.

E-mail Address vs. Display Name

Your username and password combination is the key to your e-mail privacy. You can change your password using the procedure described in Appendix A of this document. Your e-mail address is in the format username@middlebury.edu. However, the display name in the From field of messages that you send is usually in the form of Last name, First name.

Phishing Expedition Warning

Please note that there are many unscrupulous people who conduct phishing expeditions via e-mail messages. These messages may look very official and have return addresses like “Webmail Support Team” or appear to be coming from a well-known bank. The common element to these messages is that they request information from you that should be kept private such as your username and password credentials. Please note that NO legitimate Internet provider or financial institution would ever request this type of information from you. Do not respond to requests of this kind; simply delete the e-mail. If you do respond and then realize your mistake, please call the Middlebury Helpdesk at 802-443-2200 and we will guide you through changing the appropriate passwords to protect your privacy.
WebMail

Exchange is the messaging system for the Middlebury At Mills Program. You can access your electronic mail using WebMail from any networked computer on or off the Mills College campus. This section is an introduction to the use of WebMail. For complete instructions on using WebMail and more sophisticated procedures type http://go.middlebury.edu/docs in the Address field of your browser and press Enter to find the “In Depth” guides for WebMail.

WebMail On Any Computer

You can access your electronic mail, calendar, contacts file, journal, notes and tasks using WebMail from any networked computer on or off campus.

Log Into And Out Of WebMail

1. In the Address field of your browser type http://go.middlebury.edu/webmail and press Enter. The WebMail login page opens.
2. Enter your Middlebury username and password.
3. Click on Sign in.

Critical: Click sign out (in upper-right of window) to end your session.

Three Panes Of The WebMail Window

- **Left** – The navigation bar displays your folder structure and some navigation buttons.
- **Middle** – Displays the contents of the selected folder which is your Inbox when the window first opens.
- **Right** – The Reading Pane partially displays the contents of the selected message; a handy aid to deciding upon message relevance before opening it.
Use the Navigation Bar
Your folders are displayed in the leftmost pane above handy navigation buttons, click buttons or folders to navigate around in your WebMail structure. Click to shrink the buttons down to smaller icons: Click again to restore navigation buttons to their original size.

Read Messages
• Unread messages appear in the Inbox in bold type. Double-click a message to open it.
• Click (Check Messages) to refresh your Inbox and display any newly arrived messages.

Send Messages
You can send messages several ways using WebMail.
• Click New to create a new message.
Or you can select a message or open it to do the following:
• Click (Reply) to reply to the selected message.
• Click (Reply to All) to reply to recipients of the message.
• Click (Forward) to forward the message to one or more people.

Manage Messages
• Click (Move/Copy) to move the selected message to another folder, or create a new folder.
• Click (Delete) to move the selected message to the Deleted Items folder.
• In the Folder List, right-click and select Empty Deleted Items to purge messages in the Deleted Items folder.
Use WebMail To Manage Your Mailbox

Your Exchange Mailbox has a 512 MB limit (quota) imposed to remind you to manage your messaging system. When you reach your quota, the automated System Administrator sends a message to you indicating your mailbox has exceeded its size limit. If you continue to accumulate messages you may be barred from sending messages or creating new items. If your mailbox continues to grow, messages received for you are rejected by the mail server.

You must manually delete messages from your Mailbox to reduce your message space. To free space quickly, empty your **Sent Items** and **Deleted Items** folders then check all folders for large messages and messages with attachments.

**Caveat:** You must empty the **Deleted Items** folder after performing manual deletions to free the space.

1. Open the message folder desired.
   
   When you start Webmail, your **Inbox** folder is displayed. To open a different folder, use the navigation methods described previously.

2. Select the message(s) to be deleted.
   
   - On a Macintosh, click to place a checkmark in the checkbox for each message to be deleted whether they are contiguous or non-contiguous.
   
   - On a Windows computer, to select adjacent messages:
     a. Position your cursor over the first message to be selected, and click the message.
     b. Position your cursor over the last message in a block to be selected, and then while holding down **Shift**, click the message.
   
   - On a Windows computer, to select non-contiguous messages:
     a. Position your cursor over a message to be selected, and then while holding down **Ctrl**, click the message.
     b. Repeat for each message.

3. Click **Delete** (Delete). The selected messages are move to the **Deleted Items** folder.
4. Empty the **Deleted Items** folder.

- On a Windows computer, right-click [Deleted Items] in the Folder List and select **Empty Deleted Items** from the pop-up menu.

**Notes:** Message deletions simply move messages to the **Deleted Items** folder. You MUST empty the **Deleted Items** folder to truly regain space.

Be aware that you may not be able to view an entire message folder at once.

- On a Windows computer: If the **Items** indicator looks like this:

  ![Items 1 to 50 of 98]

  you must click ![Next Page] to view the next set of messages.

- On a Macintosh computer: If the **Page** indicator (bottom-right) looks like this:

  ![Page 12345... ]

  you must click ![Next Page] to view the next set of messages.
Forwarding Your Email
If you want to use another e-mail provider, there is a utility on the web that allows you to set a forwarding address for all your e-mail to the address you provide. Please be aware that forwarded messages are not duplicated on the mail server here at Middlebury College; your alternate provider will be the only source for messages sent to you during the time your mail is forwarded.

Set a Forwarding Address
1. In the Address field of your browser, type http://go.middlebury.edu/forward and press Enter. The Email Forwarding page opens.
2. Click Continue.
3. Authenticate by typing in your Username and Password in the correct boxes.
4. Click Login.
5. Click the radio button for Forward all the e-mail sent to user@middlebury.edu to this off campus e-mail address where user is your username.
6. Enter the off-campus address where you want to receive your mail in the field provided.
7. Click Make changes. Forwarding of your Outlook/Exchange account is set to the address you provided and a message displays indicating it may take as long as 30 minutes to take effect.

Discontinuation Of Forwarding
1. In the Address field of your browser, type http://go.middlebury.edu/forward and press Enter. The Email Forwarding page opens.
2. Click Continue.
3. Authenticate by typing in your Username and Password in the correct boxes.
4. Click Login.
5. Click the radio button in front of the words Do not forward my e-mail. Keep it in my Middlebury mailbox.
6. Click Make changes. Forwarding of your Exchange account is removed within 30 minutes.
The Barracuda Spam Firewall

You can add or remove addresses that are recognized as spam by the firewall and gain control of what appears in your Inbox.

1. In the Address field of your browser, type http://go.middlebury.edu/spam and then press Enter. The Barracuda Spam Firewall page opens.

2. In the Login box, do the following:
   - In the Username field, type your username.
   - In the Password field, type your e-mail password.
   - Click Login.

3. The Quarantine InBox page allows you to inspect any quarantined messages. You can select messages and then elect to deliver them, add them to the Whitelist, delete them, or classify them as SPAM.

4. Click the Preferences tab.

5. To add an e-mail address in Whitelist or Blacklist field.
   - To allow e-mail addresses and domains, type the e-mail address in the Whitelist field. The address will not be analyzed for spam but will be scanned for viruses.
   - To block e-mail address and domains, type the e-mail address in the Blacklist field.

6. Click Add.

Click Log Off (on the upper-right) to end your session.
BannerWeb For Students

You can use BannerWeb to access a variety of online services for students. After you log into BannerWeb, a menu is presented that offers the following options briefly outlined in the BannerWeb For Students Menu section.

Your First BannerWeb Login

1. From the Quick Links located on the bottom right of many Middlebury College web pages, click BannerWeb or in the Address field of your browser type http://go.middlebury.edu/bannerweb and press Enter. The User Login page displays.

2. In the User ID field, type your 8-digit College ID number include the leading zeros, which is printed on your ID card.

3. In the PIN field type your 6-digit PIN.
   - Your initial PIN for BannerWeb is your birth date in MMDDYY format.
   - For security purposes, Banner forces you to change your PIN and set a security question and answer for yourself that will allow you to reset your PIN if you forget it.

4. Click Login. The Login Verification screen displays and requires that you change your PIN.
   a. In the Re-enter Old PIN field, type your current PIN.
   b. In the New PIN field, type a new PIN.
      Note: Your BannerWeb PIN must be a six-digit number.
   c. In the Re-enter new PIN field, re-type your new PIN.

5. Click Login. You will be asked to set a Personal Security Question and Answer to identify yourself to the system in case you forget your PIN and want to reset it yourself.

6. In the Enter Question field, type a Personal Security Question that the system will ask you if you forget your PIN (this allows you to click Forgot PIN? at the initial Login page and gain access even when you have forgotten your BannerWeb PIN). Use a question that you will remember the answer to but which requests information that is not part of your public record or something that you share with casual acquaintances.
7. In the **Answer** field, type the answer to your question.

8. Click [Submit Answer], you will be logged into the system.

**Note:** If you enter your **User ID/PIN** combination 5 times incorrectly, your access to BannerWeb is disabled. You must reset your PIN using the **Personal Security Question** and **Answer** you set for yourself.

**BannerWeb PIN Changes**

1. Login to BannerWeb as you usually do.

2. Click **Personal Information**.

3. Click **Change Your PIN**.

4. You must enter your BannerWeb PIN, re-enter it for confirmation, and then click [Change PIN].

**Your BannerWeb Security Question**

When you set your first BannerWeb PIN, the system also forces you to create a personal security question which you use to reset your BannerWeb PIN if you ever forget it!

**If you forget your BannerWeb PIN**

1. On the Middlebury College home page, click [BannerWeb] or in the **Address** field of your browser type http://go.middlebury.edu/bannerweb and press [Enter]. The **User Login** page displays.

2. In the **User ID** field, enter your 8-digit College ID number (use leading zeros).

3. Click [Forgot PIN?].

4. BannerWeb asks the security question you set during your initial login. Type the answer in the field provided and then click [Submit Answer].

5. BannerWeb allows you to reset your BannerWeb PIN.
   a. In the **New PIN**: field, enter a new 6-digit BannerWeb PIN.
   b. In the **Re-enter new PIN**: field, re-enter the BannerWeb PIN.
   c. Click [Reset PIN].

Access to BannerWeb is restored.
BannerWeb For Students Menu
The BannerWeb menu of options for students includes the following items:

- **Student Records and Registration**
  - Registration – register for your classes online
  - Student Records – grades and transcripts
  - Enrollment Verifications
  - Course Evaluations
  - Volunteer Service Tracking
  - Student Organization Involvement

- **Employee**
  - Time Sheet – enter hours worked for student employees
  - Pay Information
  - Benefits and Deductions
  - Tax Forms
  - Current and Past Jobs
  - Update Emergency Contacts

- **Personal Information**
  - Change Your PIN and Security Question
  - Social Security Number Change Information
  - Mailbox Combination
  - Housing and Directory Information
  - Personal Evacuation Plan
  - Update Cell Phone and emergency contacts
  - Vehicle or Bicycle Registration

- **Student Accounts and Financial Aid**
  - View Holds
  - Account and Financial Aid Information
  - Financial Aid Links
Foreign Language Input
You can type in a foreign language on your computer without any special software. There are certain key combinations that signal your computer to use a character not found on an English keyboard. The following several sections provide instructions for input of foreign language characters.

Special Characters For Windows
All the special characters can be inserted into a MS Word document. If another product does not offer support for special character insertion, you can usually create the characters in MS Word, then cut and paste them into another product’s document.

Special Character Insertion Using Keystrokes
1. In most cases, first hold down Ctrl and strike a regular character key as indicated in the table on the next page. For some special characters you must press:
   - Ctrl and Shift and another key together
   or
   - Alt and Ctrl and Shift and another key together.
   Nothing appears on your screen yet.
2. Release all keys, and type the letter that is to carry the diacritical, as shown in the chart on the next page.
<table>
<thead>
<tr>
<th>Desired Character</th>
<th>First Keystrokes</th>
<th>Second Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>á, é, í, ó, ú</td>
<td>Ctrl + '</td>
<td>A, E, I, O, U</td>
</tr>
<tr>
<td>ã, ë, í, ò, ù</td>
<td>Ctrl + ~</td>
<td>A, E, I, O, U</td>
</tr>
<tr>
<td>ä, ë, ï, ö, ü</td>
<td>Ctrl + Shift + '</td>
<td>A, E, I, O, U</td>
</tr>
<tr>
<td>â, ë, î, ô, û</td>
<td>Ctrl + Shift + '</td>
<td>A, E, I, O, U</td>
</tr>
<tr>
<td>ñ, ñ, ò</td>
<td>Ctrl + Shift + ~</td>
<td>N, A, O</td>
</tr>
<tr>
<td>ç, Ç</td>
<td>Ctrl + '</td>
<td>C or Shift + '</td>
</tr>
<tr>
<td>æ (ash)</td>
<td>Ctrl + Shift + '</td>
<td>A</td>
</tr>
<tr>
<td>oe, OE</td>
<td>Ctrl + Shift + '</td>
<td>O or Shift + O</td>
</tr>
<tr>
<td>i</td>
<td>Ait + Ctrl + Shift + '</td>
<td>(none)</td>
</tr>
<tr>
<td>ö</td>
<td>Ait + Ctrl + Shift + '</td>
<td>(none)</td>
</tr>
<tr>
<td>ö, Ø</td>
<td>Ctrl + '</td>
<td>Ï or Shift + Ö</td>
</tr>
<tr>
<td>β</td>
<td>Ctrl + Shift + '</td>
<td>S</td>
</tr>
<tr>
<td>å, Å</td>
<td>Ctrl + Shift + '</td>
<td>A or Shift + Å</td>
</tr>
<tr>
<td>€</td>
<td>Ait + Ctrl + E</td>
<td>(none)</td>
</tr>
</tbody>
</table>
Special Characters For The Macintosh

Special Character Insertion Using Keystrokes

To type accented characters, letters with diacritical marks, or other special characters such as: á, è, ç, ß, and ñ, you must use special keystrokes.

In most cases, you will first hold down **Option** on the keyboard and then strike a regular character key as indicated below. Nothing will appear on your screen at this point. Release both keys, and then type the letter you would like to carry the diacritical, as indicated below.

For some special characters you will simply press **Option** and one key together. See the table on this page and the next page to find the character that you want to insert.

<table>
<thead>
<tr>
<th>Desired Character</th>
<th>First Keystrokes Done Together</th>
<th>Second Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>á, é, í, ó, ú</td>
<td><strong>Option</strong> + E</td>
<td>A, E, E, O, U</td>
</tr>
<tr>
<td>à, è, ì, ò, ù</td>
<td><strong>Option</strong> + E</td>
<td>A, E, E, O, U</td>
</tr>
<tr>
<td>ä, è, ï, ö, ü</td>
<td><strong>Option</strong> + U</td>
<td>A, E, E, O, U</td>
</tr>
<tr>
<td>â, ê, î, ô, û</td>
<td><strong>Option</strong> + I</td>
<td>A, E, E, O, U</td>
</tr>
<tr>
<td>ñ, ã, õ</td>
<td><strong>Option</strong> + N</td>
<td>N, A, O</td>
</tr>
<tr>
<td>ç</td>
<td><strong>Option</strong> + C</td>
<td>(none)</td>
</tr>
<tr>
<td>Ç</td>
<td><strong>Option</strong> + Shift + C</td>
<td>(none)</td>
</tr>
<tr>
<td>ß</td>
<td><strong>Option</strong> + S</td>
<td>(none)</td>
</tr>
<tr>
<td>… (ellipsis)</td>
<td><strong>Option</strong> + .</td>
<td>(none)</td>
</tr>
<tr>
<td>æ (ash)</td>
<td><strong>Option</strong> + P</td>
<td>(none)</td>
</tr>
<tr>
<td>Desired Character</td>
<td>First Keystrokes Done Together</td>
<td>Second Keystroke</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Æ</td>
<td>Option + 0</td>
<td>(none)</td>
</tr>
<tr>
<td>ï</td>
<td>Option + 1</td>
<td>(none)</td>
</tr>
<tr>
<td>ïé</td>
<td>Option + Shift + ïé</td>
<td>(none)</td>
</tr>
<tr>
<td>©</td>
<td>Option + 3</td>
<td>(none)</td>
</tr>
<tr>
<td>©</td>
<td>Option + 3</td>
<td>(none)</td>
</tr>
<tr>
<td>•</td>
<td>Option + ì</td>
<td>(none)</td>
</tr>
<tr>
<td>¶</td>
<td>Option + ì</td>
<td>(none)</td>
</tr>
<tr>
<td>€</td>
<td>Option + Shift + 0</td>
<td>(none)</td>
</tr>
</tbody>
</table>
Appendix A: Your Username and Password

Your Username and Password gives you access to your e-mail and fileserver spaces. The combination of your Username and Password is required to keep your data and communications secure. Please do not share your password with anyone.

You can learn your Username and set your Password using Middlebury’s Activate web page. You must know your 8-digit College ID number and your 6-digit BannerWeb PIN to use this program.

1. In the Address field of your web browser, type http://go.middlebury.edu/activate and press Enter. The Activate web page opens.

2. Click Continue.

3. In the ID field, type your College ID number.

4. In the PIN field, type your 6-digit BannerWeb PIN.
   Note: Your BannerWeb PIN is initially set to your birth date in MMDDYY format (e.g., a birth date of June 7, 1984 = 060784). You are forced to change this number the first time you log into BannerWeb. If your birthday doesn’t work, try entering 010101 as your PIN.

5. Click Logon.

5. The Middlebury College Agreement Statement for Responsible Computing displays. Read the statement, then do the following:

   a. Click on the Agree radio button to bullet it.

   b. Click Submit.

6. Your campus-wide Username is displayed at the top of the page like the example below.

   7. Your username is: jklinger

In the Enter New Password field, type your new password. Your new password must:

   - be at least 8 characters long
   - contain at least 1 uppercase character
   - contain at least 1 lowercase character
   - contain at least 1 numeric digit
- contain at least 1 of these special characters:
  \sim \star _ ? \backslash . / ! + - \{ \} [ ]

- contain no spaces or other special characters not listed above.

8. In the **Confirm New Password** field, type your new password again.

9. Click [Continue].

   - If you typed an invalid password or the confirmation did not match, an error message tells you which error you made and allows you to try again.

   - For successful password changes, a confirmation message displays indicating how much time must elapse before you can use your new password on each system.

9. Restart your computer.

**Note:** If you forget your password, you can use this program to set a new one.
Appendix B: VPN

Middlebury’s license with Sophos Anti-Virus allows for Middlebury at Mills Students to download the software onto their personal computers. In order to do this, you will first need to connect to Middlebury’s network via VPN (Virtual Private Networking).

VPN (Virtual Private Networking)
Virtual Private Networking allows you to connect to the Middlebury College network from off-campus in order to use applications as if you were on campus.

WebVPN
The recommended method for connecting from Middlebury at Mills for both PC and Mac users is the WebVPN. If you have trouble connecting, visit https://mediawiki.middlebury.edu/wiki/LIS/VPN for alternative instructions.

To use the WebVPN client:
1. Make sure you have an internet connection and open a web browser (IE or Firefox).
2. In the Address field type https://vpn.middlebury.edu/ and press Enter. Your browser will display the following page:

3. In the Username field, type your college username.
4. In the Password field, type your password.
5. Click “Sign In”
6. You will be taken to the following screen:
7. Click “Start”
8. Your browser will display the screen below. Wait while the connection is established.

9. When the connection is complete, your screen will look like the one pictured below, and a gold lock will appear on the bottom right of your screen.
Index

BannerWeb 26
  BannerWeb PIN 11, 26, 27, 33
  BannerWeb PIN change 27
  College ID number 26
  logging into 26
  personal security question 26, 27
College ID number 26, 27, 33
Deleted Items folder 22
DHCP 14
Documentation 6
e-mail See WebMail
  display name 19
  forwarding 24
  policy 19
  remove forwarding 24
  your e-mail address 19
foreign language character input
  Macintosh 31
  Windows 29
forwarding e-mail 24
go utility 5, 6, 18, 24
  Quick Text 18
how-to guides 6
IP address 14
LIS website 5
password 11, 33
phishing expeditions 19
remove forwarding of e-mail 24
SPAM
  phishing expeditions 19
special characters See foreign language character input
Technology Helpdesk 5
  documentation 6
username 11, 19, 33
VPN 35
web navigation 18
WebMail 20
  managing messages 21, 22
  navigation bar 20, 21
  on a Windows computer 20
  quota 22
  reading messages 21
  sending messages 21